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Introduction
 
TL Viewer provides a graphical way to organize your data and files. You can use the viewer to open, copy
and edit data files. You can also use it to move, edit, copy, view records as graphs, you can even print
graphs using the Science Graph tool.
The TL Viewer displays one or more windows - either data file windows or graphs windows.
A data file window lists all the records in the file, where each sample is listed using the data type (TL,OSL
etc), the run no. and the sample no. See also the records.
A graph window views one or several data record curves.
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Files
The System II data files holds a lot of information about the sample that was neglected in the former versions
of the TL/OSL software.
To get a complete reference of the new file format please refer to file formats.
 
Creating a data file.
Opening Data file.
Saving a Data file or converting to other formats.
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Creating a data file
You can create a data file from scratch, this could be an idea if you have some data you would like to
compare with the measured data or if you wants to collect records from several data files and merge them
into a new file.
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Opening a datafile
Opening a Data file Files
You can use the File Open dialog to find and open previous created datafiles files.
Choose File|Open to edit a datafile using the Select Data file Name Dialog Box.

Or use the short cut Ctrl-O or click the speed button 
Open Data file Dialog Box
Use the Open Datafile dialog box to load an existing sequence file into the Datafile Editor. You can only have
as many files open as you wish, but your computer sets some restrictions.
File Name Edit Box
Enter the name of the file you want to load or wildcards to use as filters in the Files list box. If you use
wildcards you can press return or click the OK button to use the mask on all files, the files in the mask are
now listed in the File List Box.
Files List Box
Displays the files in the current directory that match the wildcards in the File Name edit box or the file type in
the List Files Of Type combo box.
List Files Of Type Combo Box
Choose the type of file you want to open; the default file type is System II datafiles (.BIN). All files in the
current directory of the selected type appear in the Files list box.
Choose:
    System II     To look for new data files
    Version 4.65     To look for old data files
    Version 5.0     To look for old data files supporting monochromators
 
Note   You can open version 3 data files, but you cannot save them in version 3 format.
To save them you must convert them to version 4,5 or system II format.
 
Directories List Box
Select the directory whose contents you want to view. In the current directory, files that match the wildcards
in the File Name edit box or the file type in the List Files Of Type combo box appear in the Files list box.
Drives Combo Box
Select the current active drive. The directory structure for the current drive appears in the Directories list box.
If you are using Windows 95 or Windows NT you can click on the Network button to connect a network drive.
 
When a file is opened the individual data records are show in a number of columns:
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The format of the identification of the records are
 
<type>( <run>, <set>, <sample>[/<grain>][, <curve no>])
 
Where:
 
<type>:     The type of command, e.g. OSL, TL, POSL
<run>:     The run number
<set>:      The set number
<sample>:      The sample number
<grain>:     The grain number if a single grain measurement
<curve no>:     The curve number if more curves are stored for the same  (<run>, <set>, <sample>)
 
The square brackets indicate that these parameters are not always shown (cf. Above)
 
 
 
 
Note   The dialog text depend on the language your Windows uses
Refer to your local Windows Manual.
 
 
Warning   If you select an improper formatted data file the application may crash, this could be the case when you try to
open a file that has the correct file extension.
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Saving or converting a datafile
 
Choose File|Save As, File|Save or the FileSave Speedbutton to save the current datafile to a different name
or location.
Save Sequence Dialog Box
Use the Save dialog box to change the data file name or to save the datafile in a new location. If the file
name already exists, The application asks if you want to replace the existing file.
File Name Edit Box
Enter a name for the data file you are saving.
Files List Box
Displays the files in the current directory that match the file type in the Save File as Type combo box.
Save File As Type Combo Box
Choose a file extension; the default is .BIN (System II). If you select another extension you can convert the
file.
Directories List Box
Select the directory where you want to store the file. In the current directory, files that match the file type in
the Save Files As Type combo box appear in the Files list box.
Drives Combo Box
Select the current active drive. The directory structure for the current drive appears in the Directories list box.
If you use Windows 95 or Windows NT you can click the Network button to connect a network drive.
Converting files
To convert to one of the supported formats select the format you wants to save your data as in the file type
listbox.
 
 
You can open files from version 3, version 4.65, version 5.0 or System II.
You can convert to Version 4.65, version 5.0 or System II.
 
When you convert to an older file format, you loose some information, because the old formats supports less
information.
 
More about file formats.
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Records
You can select one or several records using the mouse or the keyboard (refer to your Windows
documentation).
You can select a record then hold down the Shift key and select another and all the items in between the two
selected records also become selected. If the you doesn't hold down the Shift or Ctrl key while selecting a
second record, the first selected record becomes unselected--in other words, you must use the Ctrl key to
select multiple non-contiguous records, or the Shift key to select a range of records.
 
 
Warning If you select more than one record, you perform the functions on all records. Be aware that this is a strong
feature when used correctly, but when used incorrectly it is a fatal tool.
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Using the mouse with the Record list
To navigate the list:
If the client window are to small to hold all data records within it, a scrollbar are added to the bottom of the
client window.
To scroll one page forward just click in the scrollbar on the right side of the indicator.
To scroll one page backward click in the scrollbar on the left side of the indicator.
You also drag the indicator to select a desired view.
To select one record:
Click on the desired record and it get highlighted.
To select two or more records in sequence:
    1.     Click on the first record you want to select.
    2.     Press and hold down the shift key while you click the last record in the sequence.
 
To select two or more records out of all records.
Press and hold down the Ctrl key, while you select the desired records.
To select all records in a list:
Press Ctrl-/ (slash).
To cancel a selection
Press and hold down the Ctrl key, while you click on the record(s) you want to deselect.
 
You can combine the Shift and Ctrl technique. In addition you can combine with the keyboard.
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Using the keyboard with the Record list
You can use the keyboard to navigate or select a record or a group of records.
To navigate in the list of records use
UP or DOWN ARROW selects the record above or below the selection
LEFT or RIGHT ARROW selects the record in the previous or next column.
END to select the last record in the list
HOME to select the first record in the list
PAGE UP to select the record at the top of the previous screen. (if the window are to small to hold all records
a scrollbar in the bottom of the Window indicate this)
PAGE DOWN to select the records at the top of the next screen.
A character to select the next record who identifier starts with the character.
To select two or more records in sequence:
    1.     Select the first record.
    2.     Press and hold down the shift key while you traverse to the last record in the sequence.
 
To select two or more records out of all records.
    1.     Use the arrow keys to move to the first record you want to select.
    2.     Press SHIFT+F8, the selection cursor begins to blink.
    3.     Move to the desired records, select them with spacebar.
    4.     Press SHIFT+F8 when you are finished selecting records.
 
To select all records in a list:
Press Ctrl-/ (slash).
To cancel a selection
Press SHIFT+F8 and traverse to the record you wants to deselect and press SPACBAR to deselect it.
 
You can combine all three techniques. In addition you can combine with the mouse.
 
More on using the keyboard
If you like to read more on how to use the keyboard please refer to your Windows manuals Appendix A
(keyboard shortcuts).
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Edit Data Values
Using the data value grid you can modify each channels value.
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Add Data Values
Add some channels to the record at the end
N/A in this version
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Delete Data Values
Delete some channels
N/A in this version
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Add Record
Add an empty record to the file
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Copy
Copy the selected records and put them into the Windows Clipboard, where they can be pasted into other
Windows application directly.
 
Most of the time you use the Windows clipboard with the TL/OSL application only, you will seldom use it with
third-part Windows applications so we have divided the functions for internal and external use.
Using the Clipboard inside the application:
Using the clipboard internal are memory and time consuming because it is not the standard Windows way of
doing things. The receiver of information knows what to do with the information.
Copy: Copy selected records to a data file
    1.     Select the records you want to copy.
    2.     From the Record menu choose Drag. Or from the Context menu choose Drag. The mouse pointer
changes shape.
    3.     Activate the destination data file.
    4.     Click once with the mouse within the list.
 
Paste: Inserts records from the clipboard to the end of the active datafile
    1.     Activate the desired data file.
    2.     From the Record menu choose Paste.
 
Cut: Delete the selected records and insert them into a data file
    1.     Select the records you want to cut.
    2.     From the Record menu choose Cut. Or from the Context menu.
    3.     Activate the destination data file.
    4.     From the Record menu choose Paste.
 
Using the Clipboard with Windows third party applications
 
Using the clipboard between Windows applications
You can copy one or several records data values to the clipboard.
 
1. Select the record(s).
2. From the Record menu choose Copy Or from the context menu choose Copy Or use the short cut Ctrl-C.
3. Swap to the destination application.
4. From the Edit menu choose paste.
 
Each record are copied into one row of data value, separated with tabs, this scheme are supported by
Microsoft Excel and others.
If you want to import data values into an application not supporting this scheme you should first export the
data values as an ASCII file.
 
 
 
Warning   Cannot be used to paste to the TL Viewer application. Use the drag feature.
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Paste - Full
N/A in this version
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Paste - Data only
N/A in this version
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Delete
Delete the selected records!



 

Risø TL/OSL Viewer- Cut 20

Cut
Cut the selected records and put them into the Windows Clipboard, where they can be pasted into other
Windows application directly.
 
Warning   Cannot be used to paste to the TL Viewer application. Use the drag feature.
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Export - Tab
N/A in this version
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Export - Comma
N/A in this version
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Edit
Choose File-Edit, use F2 or click the  button to edit the record header.
The record header data is shown on 5 tabs.
 
Note   When you modify one of the settings in the dialog, the background turns into red, this helps you to
see what you changed before clicking ok or cancel.
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View Graph
When you have selected one or several records you can view them as a graph
Choose Records - View Graph
Or
From the context menu choose View Graph
Or
use the short-cut Ctrl-G.
 
See also graph window.
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Graph Window
The graph window can hold up to 16 curves, each curve can be individual defined to meet your specific
needs, so you can make dias, overheads fancy prints etc. of the graph.
 
In the graph window you can use the context menu (right mouse button) to reach the most common
formatting functions.
 
Edit the Top Title Caption:
Using The Graph Menu:
    -     Choose Caption from the Graph, Title, Top Menu.
    -     Edit the Caption.
Using The Context Menu:
    -     Click the Right mouse button to pop up the context menu.
    -     Choose Caption from the Titles, Top menu.
 
Edit the Legend appearance:
Using The Graph Menu:
    -     Choose Left or Right from the Titles, Legend menu.
    -     Select Left to place the legend text in the left side of the Curve Document.
 
To edit the font style used:
Edit Top Title Font:
    -     Choose Font from the Graph, Titles, Top, Font menu. Or use the Context Menu (Hold down the right
mouse button).
    -     Edit the Font settings using the Windows Font Dialog Box
Edit Top Title Font:
    -     Choose Font from the Graph, Titles, Top menu. Or use the Context Menu (Hold down the right mouse
button).
    -     Edit the Font settings using the Windows Font Dialog Box
Edit Legend Font:
    -     Choose Font from the Titles, Legend, Font menu. Or use the Context Menu (Hold down the right
mouse button) and
    -     Edit the Font settings using the Windows Font Dialog Box
Edit X-Axis Title Font:
    -     Choose X-Axis from the Graph, Axis menu. Or use the Context Menu (Hold down the right mouse
button).
    -     Click Font in the Axis group.
    -     Edit the Font settings using the Windows Font Dialog Box
Edit Y-Axis Title Font:
    -     Choose Y-Axis from the Graph, Axis menu. Or use the Context Menu (Hold down the right mouse
button).
    -     Click Font in the Axis group.
    -     Edit the Font settings using the Windows Font Dialog Box
Edit Tick Title Font:
    -     Choose X-Axis from the Graph, Axis menu. Or use the Context Menu (Hold down the right mouse
button). Or Y-Axis.
    -     Click Font in the Ticks group.
    -     Edit the Font settings using the Windows Font Dialog Box
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Close
Closes the current graph window
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Print
Print the current graph using the current printer and printer settings, if you want to change printer or printer
settings then use the Windows Control Panel, refer to your Windows documentation.
Using the Windows Control Panel you can:
    -     Change page orientation.
    -     Change printer even log to a network printer.
    -     Change colour quality etc.
    -     Change paper
 



 

Risø TL/OSL Viewer- Titles - Top Font 30

Titles - Top Font
Changes the top title font, using the Windows standard Font dialog.
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Titles - Top Caption
Changes the top caption text
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Titles - legend font
Changes the legend font, to draw the legend you must define the series Legends description text, using the
Windows standard Font dialog.
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Titles - legend left or right
Specify where to draw the legend text left most or right most
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X-Axis or Y-Axis
You use the Axis Options dialog box to edit the Axis properties.
The Y-axis autoscale to the current data series and the size of the graph window.

Axis.
Caption:     The axis text.
Font:      The font used to draw the text, selecting it using the Windows Font dialog.
Origin:     Where to start the ticks in real figures (channel 1).
Scale:      What to multiply each channel with.
Pen
Style: pen style used to draw axis line and tick lines.
Width:     the width of the pen.
Color:     the color to use, select it using the Windows Colour dialog
Ticks
View:     Check none when you do not wants to draw the axis line, the tick marks and the tick text,
check axis to draw the line only.
Size:     The length or size of the tick marks.
Font:     The font used to draw the tick mark text. Select it using the Windows Font dialog.
First:     Where to place the first tick mark.
Gap:     Gap between the rest of the tick marks.
Def. Tick:     When checked the application auto select the ticks to fit the window (Y-axis only), if you
change the First or the Gap the Def. Tick is unchecked.
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Series
Each data series can be edited individually, you can use the Series dialog box, the box is a multi page dialog
box:

Points
Marker:     draw a marker on each datapoint.
Style:     line style used for the marker
Width:     The width of the line
Color:     The color used to draw the marker, select it using the Windows Color dialog box.

Connection
Connect:     How to connect each data point, only Line and not connected are supported in this
version.
Style:     The line style used to draw each line, note that windows ignore the line style when the line
widht is greater than one.
Width:     The width of the line.
Color:     The color used for the line, select it using the Windows Colour dialog box.
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Legend
Desc.:     The description for the data series, only when this is defined the legend is drawn.

Integration
Lower:     The lower integration limit, the limit is used for all series, enter values in real-values, real
values is calculated into channels automatically. You cannot type in a value not within the Low-High
limits for the curve.
Upper:     The upper integration limit.
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Columns
Select the number of columns the data records are listed in. Default is 2.
You can use the short cuts or the Records-Columns function.
Ctrl-4     4 columns view.
Ctrl-6     6 columns view.
Ctrl-8     8 columns view.
Ctrl-0     10 columns view.
Ctrl-2     12 columns view.
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File Formats
 
The results from a run of a Risø TL/OSL sequence are stored in a so-called BIN file.
For all versions of the BIN files, the version number is stored in the first 2 byte of the header.
 
 
V.6 (file extension: binx)
 
The file format us used by Sequence editor V.4.20 and later
 
Description Name Type Length

(bytes)

 
Header size and structure

   

Data format version number Version Small Integer 2

Length of this record (†) Length Long Integer 4

Length of previous record (†) Previous Long Integer 4

Number of data points NPoints Long Integer 4

 
Sample characteristics

   

Run number Run Small Integer 2

Set Number Set Small Integer 2

Carousel position Position Small Integer 2

Grain Number GrainNumber Small Integer 2

Curve number (for multiple curve operations) CurveNo Small Integer 2

X position of a single grain XCoord Small Integer 2

Y position of a single grain YCoord Small Integer 2

Sample name Sample String 21

Comment Comment String 81

 
Instrument and sequence characteristics

   

System ID SystemID Small Integer 2

File name (.SEC, .BINX etc) FName String 101

User name User String 31

Data collection time (hh-mm-ss) Time String 7

Data collection date (dd-mm-yy) Date String 7

 
Analysis

   

Data type (#) DType Byte 1

Bleaching time BL_Time Single 4

Bleaching unit (mJ, J, secs, mins, hrs) BL_Unit Byte 1

Normalisation factor (1) Norm1 Single 4

Normalisation factor (2) Norm2 Single 4

Normalisation factor (3) Norm3 Single 4

Background level BG Single 4
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Number of channels to shift data Shift Small Integer 2

Tag Tag Byte 1

Reserved for internal use   20

 
Measurement characteristics

   

Luminescence type (‡) LType Byte 1

Light Source (*) LightSource Byte 1

Optical Stimulation Power LightPower Single 4

Low (temperature, time, wavelength) Low Single 4

High (temperature, time, wavelength) High Single 4

Rate (heating rate, scan rate). Rate Single 4

Sample temperature Temperature Small Integer 2

Measured temperature MeasTemp Small Integer 2

Preheating temperature An_Temp Single 4

Preheating time An_Time Single 4

TOL ‘delay’ channels Delay Small Integer 2

TOL ‘on’ channels On Small Integer 2

TOL ‘off’ channels Off Small Integer 2

Irradiation time IRR_Time Single 4

Irradiation type (alpha, beta or gamma) IRR_Type Byte 1

Irradiation dose rate (Gy/s) IRR_DoseRate Single 4

Irradiation dose rate error (Gy/s) DoseRateErr Single 4

Time since last irradiation (s) TimeSinceIrr Long Integer 4

Time unit (time tick) for pulse parameters (s) TimeTick Single 4

On-time for pulsed stimulation (in time ticks) OnTime Long Integer 4

Stimulation period (on+off time in time ticks) StimPeriod Long Integer 4

PMT signal gating enabled GateEnabled Byte 1

Start of gating (in time ticks from start of on pulse) GateStart Long Integer 4

End of gating (in time ticks from start of on pulse) GateEnd Long Integer 4

Photon Timer enabled PTenabled Byte 1

PMT dead time correction enabled DTenabled Byte 1

PMT dead time (s) DeadTime Single 4

Stimulation power corresponding to 100% (mW/cm2) MaxLPower Single 4

XRF acquisition time (s) XrfAcqTime Single 4

XRF X-ray high voltage (V) XrfHV Single 4

XRF X-ray current (uA) XrfCurr Long Integer 4

XRF dead time fraction XrfDeadTimeF Single 4

Reserved for internal use  Byte 24

    
Length of header   447

 
Data

   

Data array of NPOINTS Long Integers DPoints Long Integer 4x
NPoints
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Notes:
 
†     The records are of a variable length since the number of data points recorded (NPOINTS) may vary from one to
9,999 (this may be expanded in the future). A record with a single data point in it will be 423+(1x4) = 427 bytes long,
while one with 2000 data points will be 423+(2000x4) = 8423 bytes long. Thus there is a considerable saving of disc
space by having semi-variable length records. However, once created the length of the record is fixed (it does not
make sense to be able to delete or add single data points) and is recorded in the variable LENGTH. This allows the
program to be able to step through from one record to another without having to search for specific end of record
markers. In order to be able to move UP through a file the length of each previous record is also stored in a record (this
will be zero in the first record).
 
    Strings are stored in Pascal format. That is with an additional byte used to define the length of the string. Thus
the number of bytes used to store the string is one byte longer than the string itself. Thus the Date is stored as a 6
character string (ddmmyy), but this requires 7 bytes.
 
‡     The different types of luminescence that can be specified are as follows:-
Value LTYPE Description Associated device

0 TL Thermoluminescence -

1 OSL Optically stimulated luminescence OSL lamp / Blue diodes

2 IRSL Infrared stimulated luminescence IR diode array or IR laser

3 M-IR Infrared monochromator scan IR monochromator

4 M-VIS Visible monochromator scan Visible monochromator

5 TOL Thermo-optical luminescence Any optical stimulation

6 TRPOSL Time Resolved Pulsed OSL Any optical stimulation

7 RIR Ramped IRSL IR diode array or IR laser

8 RBR Ramped Blue LEDs Blue diodes

9 USER User defined -

10 POSL Pulsed OSL Blue or IR diode arrays

11 SGOSL Single Grain OSL Green or IR laser

12 RL Radio Luminescence Beta irradiation source

13 XRF X-ray Fluorescence
 

X-ray unit

 
#     The various data types specified by DTYPE are primarily designed for use when calculating equivalent doses. The
different data types are as follows.
Value Data Type Irr. Bl.

0 Natural   
1 N+dose   
2 Bleach   
3 Bleach + dose   
4 Natural (Bleach)   
5 N+dose (Bleach)   
6 Dose   
7 Background   
*     The values for the light source are as follows:
Value Light Source
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0 None

1 Lamp

2 IR diodes / IR Laser

3 Calibration LED

4 Blue Diodes

5 White light

6 Green laser (single grain)

7 IR laser (single grain)
 
 
V.4 (file extension: bin)
 
The file format us used by Sequence editor V.4.00 to V.4.12
 
Description Name Type Length

(bytes)

Data format version number Version Small Integer 2

Length of this record (†) Length Small Integer 2

Length of previous record (†) Previous Small Integer 2

Number of data points NPoints Small Integer 2

Luminescence type (‡) LType Byte 1

Low (temperature, time, wavelength) Low Single 4

High (temperature, time, wavelength) High Single 4

Rate (heating rate, scan rate). Rate Single 4

Sample temperature Temperature Small Integer 2

X position of a single grain XCoord Small Integer 2

Y position of a single grain YCoord Small Integer 2

TOL ‘delay’ channels Delay Small Integer 2

TOL ‘on’ channels On Small Integer 2

TOL ‘off’ channels Off Small Integer 2

Carousel position Position Byte 1

Run number Run Byte 1

Data collection time (hh-mm-ss) Time String 7

Data collection date (dd-mm-yy) Date String 7

Sequence name Sequence String 9

User name User String 9

Data type (#) Dtype Byte 1

Irradiation time IRR_Time Single 4

Irradiation type (alpha, beta or gamma) IRR_Type Byte 1

Irradiation unit (Gy, Rads, secs, mins, hrs) IRR_UNIT Byte 1

Bleaching time Bl_Time Single 4

Bleaching unit (mJ, J, secs, mins, hrs) Bl_Unit Byte 1

Annealing temperature An_Temp Single 4

Annealing time An_Time Single 4
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Normalisation factor (1) Norm1 Single 4

Normalisation factor (2) Norm2 Single 4

Normalisation factor (3) Norm3 Single 4

Background level BG Single 4

Number of channels to shift data Shift Small Integer 2

Sample name Sample String 21

Comment Comment String 81

Light Source (*) LightSource Byte 1

Set Number Set Byte 1

Tag Tag Byte 1

Grain Number Grain Small Integer 2

Optical Stimulation Power LightPower Single 4

System ID SystemID Small Integer 2

Reserved for internal use   20

Curve number (for multible curve operations) CurveNo Small Integer 2

Time unit for pulse parameters TimeTick Single 4

On-time for pulsed stimulation (in time ticks) OnTime Long Integer 4

Stimulation period (on+off time in time ticks) StimPeriod Long Integer 4

PMT signal gating enabled GateEnabled Byte 1

Start of gating (in time ticks from start of on pulse) GateStart Long Integer 4

End of gating (in time ticks from start of on pulse) Gateend Long Integer 4

Photon Timer enabled PTenabled Byte 1

Reserved   10

    
Length of header   272

    
Data array of NPOINTS Long Integers DPoints Long Integer 4 x

NPOINTS
 
 
V.3 (file extension: bin)
 
The file format us used by Sequence editor V.3.xx
 
Description Name Type Length

(bytes)

Data format version number Version Small Integer 2

Length of this record (†) Length Small Integer 2

Length of previous record (†) Previous Small Integer 2

Number of data points NPoints Small Integer 2

Luminescence type (‡) LType Byte 1

Low (temperature, time, wavelength) Low Single 4

High (temperature, time, wavelength) High Single 4

Rate (heating rate, scan rate). Rate Single 4
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Sample temperature Temperature Small Integer 2

X position of a single grain XCoord Small Integer 2

Y position of a single grain YCoord Small Integer 2

TOL ‘delay’ channels Delay Small Integer 2

TOL ‘on’ channels On Small Integer 2

TOL ‘off’ channels Off Small Integer 2

Carousel position Position Byte 1

Run number Run Byte 1

Data collection time (hh-mm-ss) Time String 7

Data collection date (dd-mm-yy) Date String 7

Sequence name Sequence String 9

User name User String 9

Data type (#) Dtype Byte 1

Irradiation time IRR_Time Single 4

Irradiation type (alpha, beta or gamma) IRR_Type Byte 1

Irradiation unit (Gy, Rads, secs, mins, hrs) IRR_UNIT Byte 1

Bleaching time Bl_Time Single 4

Bleaching unit (mJ, J, secs, mins, hrs) Bl_Unit Byte 1

Annealing temperature An_Temp Single 4

Annealing time An_Time Single 4

Normalisation factor (1) Norm1 Single 4

Normalisation factor (2) Norm2 Single 4

Normalisation factor (3) Norm3 Single 4

Background level BG Single 4

Number of channels to shift data Shift Small Integer 2

Sample name Sample String 21

Comment Comment String 81

Light Source (*) LightSource Byte 1

Set Number Set Byte 1

Tag Tag Byte 1

Grain Number Grain Small Integer 2

Optical Stimulation Power LightPower Single 4

System ID SystemID Small Integer 2

Reserved for internal use   36

On-time for pulsed stimulation (s) (#) OnTime Single 4

Off-time for pulsed stimulation (s) (#) OffTime Single 4

Enable flags (PMT Gating and Photon Timer enable) (#) EnableFlags Byte 1

On-gate delay (s) (#) OnGateDelay Single 4

Off-gate delay (s) (#) OffGateDelay Single 4

Reserved   1

    
Length of header   272
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Data array of NPOINTS Long Integers DPoints Long Integer 4 x
NPOINTS

 
Notes:
 
#     The pulsing parameters are only stored from Sequence Editor V.3.30 and onwards
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Arranging Windows and Icons
 
If several windows are open or reduced to icons, you may need to arrange the windows and icons so that
you can see them all.
 
To arrange windows
From the Window menu choose Tile Vertically from the Window menu to arrange windows side by side so
that they do not overlap.
Or choose Tile Horizontally from the Window menu to arrange windows top to bottom so that they do not
overlap.
Or choose Cascade to arrange windows so that they overlap (starting in the upper-left corner of the
application window). The title bar of each window remains visible
 
To arrange icons
From the Window menu, choose Arrange Icons.
 
To maximize a window
double click the title bar or click the maximize button.
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Support
 
To report any problems encountered while using your Risø TL/OSL Reader or to make inquiries regarding
software upgrades and additional hardware options, please feel free to contact us in any of the following
ways:
 
    +     By email: henc@dtu.dk
    +     By mail:

Att. Henrik Christiansen
DTU Nutech
Center for Nuclear Technologies
DTU Risø Campus
Frederiksborgvej 399, Building 201
DK-4000 Roskilde
Denmark

    +     By phone: +45 4677 4932
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